Placement of Culvert and Varying Water Levels
## Outline

1 Description

2 Finite Element Model
   2.1 Geometry
   2.2 Properties
   2.3 Boundary Conditions
   2.4 Water Levels
   2.5 Mesh

3 Geomechanical Staged Construction Analysis
   3.1 Commands
   3.2 Results

Appendix A Additional Information

---

Placement of Culvert and Varying Water Levels | [https://dianafea.com](https://dianafea.com)
1 Description

This tutorial demonstrates the staged construction analysis for placement of a culvert. We assume linear elastic material behavior in this analysis. Water level varies in the different stages and results are presented in terms of effective stresses and pore pressures, as well as, Mohr-Coulomb stress capacity. DIANA calculates the shear stress capacity of the soil against the Mohr-Coulomb failure criterion. Figure 1 shows the global layout of the culvert structure in the underground and Figure 2 shows the detail of the culvert with relevant dimensions.

Figure 1: General layout of structure in the underground

Figure 2: Detail of the culvert
2 Finite Element Model

We start a new project for plane strain structural analysis. We choose quadratic mesh order. The model size is set to 1 km (-500 to 500 m) to include the entire model. We choose meter for the unit length, kg for mass and N for force. The units and the directions are displayed in the reference system section of the geometry browser.

Figure 3: New project dialog
Figure 4: Geometry browser - units
Figure 5: Geometry browser - units
2.1 Geometry

The model consists of five parts: soil basis, the culvert, a left and a right opening in the culvert and the soil cover. Each of these parts are created as a polygon sheets and initially assigned with soil material behavior. We define the plane strain model in the \( XY \) plane. The \( XY \) coordinates for the Soil basis in meters are: (-10, -10), (10, -10), (10, 0), (7.2, 0), (3.6, -4.2), (-3.6, -4.2), (-7.2, 0), and (-10, 0).
The XY coordinates in meters for the Culvert are: (-3.6, -4.2), (3.6, -4.2), (3.6, -3.8), (3.2, -3.8), (3.2, -1.8), (-3.2, -1.8), (-3.2, -3.8), and (-3.6, -3.8).

**Main menu ➔ Geometry ➔ Create ➔ Add polygon sheet**  
[Fig. 8] - [Fig. 9]
The XY coordinates in meters for the Cover soil are: (-7.2, 0), (-3.6, -4.2), (-3.6, -3.8), (-3.2, -3.8), (-3.2, -1.8), (3.2, -1.8), (3.2, -3.8), (3.6, -3.8), (3.6, -4.2), and (7.2, 0).

**Figure 10:** Polygon sheet for *Cover soil*

**Figure 11:** View *Cover soil*
We define a polygon sheet for the left opening - *Opening left* - with the XY coordinates in meters: (-2.9, -3.8), (-0.15, -3.8), (-0.15, -2.1), and (-2.9, -2.1).

**Main menu ➔ Geometry ➔ Create ➔ Add polygon sheet [Fig. 12] [Fig. 13]**
Then, we duplicate this sheet to create the new sheet named *Opening right*.

**Main menu ➔ Geometry ➔ Shapes ➔ Opening Left ➔ Duplicate**  ![Fig. 14]

**Geometry browser ➔ Geometry ➔ Shapes ➔ Opening left ➔ Rename ➔ Opening Right**  ![Fig. 14]

---

**Figure 14: Duplicate - Opening left**

**Figure 15: Opening Right**
The sheet *Opening right* is translated 3.05 m in the positive $X$ direction.

Main menu ➔ Geometry ➔ Modify ➔ Move shape ➔ [Fig. 16] [Fig. 17]
Finally we subtract the two sheets sheets - *Opening left* and *Opening right* - from the sheet *Culvert*, in which keep the both opening sheets as tools.

**Main menu** ➔ **Geometry** ➔ **Modify** ➔ **Subtract shapes**  [Fig. 18]  [Fig. 19]
2.2 Properties

For the soil, linear material behavior is defined with following properties: Young’s modulus $E = 1E+10$ N/m², Poisson ratio $\nu = 0.25$, density $\rho = 1800$ kg/m³, porosity $n = 0.3$, effective stress ratio $K_0 = 0.577$. We also define the friction angle $\phi = 0.523599$ rad and cohesion $C = 1E+4$ N/m² for Mohr-Coulomb capacity check in the post-processing.
For the concrete we use a linear elastic material with the following properties: Young’s modulus $E = 3E+10 \text{ N/m}^2$, Poisson ratio $\nu = 0.18$, density $\rho = 2500 \text{ kg/m}^3$.

At the start of the analysis the concrete material is not assigned to any of the shapes. Only when the culvert is placed, the material assigned to the culvert is changed from soil to concrete.

---

**DianaIE**

Shape Properties ➔ Material ➔ Add material ➔ Edit material ➔ [Fig. 24] ➔ [Fig. 25]

---

![Figure 24: Add concrete material](https://dianafea.com)

![Figure 25: Linear properties for concrete](https://dianafea.com)
2.3 Boundary Conditions

We assign the supports in $X$ direction to the two vertical outside edges and in $Y$ direction to the bottom edge of the Soil basis sheet.

**Figure 26**: Supports in $X$ direction

**Figure 27**: Supports in $Y$ direction

**Figure 28**: Supports in $X$ direction

**Figure 29**: Supports in $Y$ direction
2.4 Water Levels

In a staged construction analysis the deadweight load is generated and applied automatically in the first stage. In this tutorial we apply two user-specified water levels which change at stage transitions. First we define a constant water level at \( y = -2 \text{ m} \). Next, we define a water level with head of \( y = -2 \text{ m} \) at the outer edges of the model and with head of \( y = -5 \text{ m} \) under the excavation.

Main menu ➔ Geometry ➔ Water levels ➔ Add ➔ [Fig. 30] ➔ [Fig. 33]

![Geometry browser - water levels](image-url)

![Properties of water level at -2m](image-url)

![Properties of water level at -5m](image-url)

![Water levels](image-url)
2.5 Mesh

We assign a mesh size of 0.3 m to the shapes. Then we generate the mesh.

Figure 34: Mesh properties

Figure 35: Finite element mesh
3 Geomechanical Staged Construction Analysis

3.1 Commands

We define a geomechanical staged construction analysis with 6 stages. We rename the analysis as Culvert installation. The names of the stages are respectively: Initialization, Lower water level, Excavate soil, Place culvert, Cover culvert and Rise water level.
The first stage - *Initialization* - is of type *specified steady state* with the water level $WL = -2m$. The five mesh sets are active, as well as, the $BC$ support set.

**Analysis browser**  ➔  Culvert installation  ➔  Geomechanical staged construction  ➔  Initialization  ➔  Active model parts  

[Fig. 39]  [Fig. 40]
The second stage - Lower water level - is of type specified steady state with the water level $WL=-5m$. All five mesh sets are active, as well as, the BC support set.

**Analysis browser** ➔ Culvert installation ➔ Geomechanical staged construction ➔ Lower water level ➔ Active model parts

**Fig. 41** Analysis browser

**Fig. 42** Properties stage Lower water level

---

**DianaIE**

Placement of Culvert and Varying Water Levels | https://dianafea.com
The third stage - Excavate soil - is of type Specified steady state with the water level WL=-5m. Here, only the mesh set Soil basis is active, as well as, the BC support set.
The fourth stage - *Place culvert* - is of type *Specified steady state* with the water level $WL=-5m$. Here, the mesh set *Soil basis* is active and the mesh set *Culvert* is reactivated, but now with concrete material. The *BC* support set is also active.

Figure 45: Analysis browser

Figure 46: Properties stage *Place culvert*
The fifth stage - **Cover culvert** - is of type *Specified steady state* with the water level $WL=-5m$. Here, the mesh set *Soil basis* is active and the mesh set *Culvert* with concrete material is active together with the mesh set *Cover soil*. The BC support set is also active.
The sixth and last stage - *Rise water level* - is of type *Specified steady state* with the original water level $WL=-2\text{m}$. Here, the mesh set *Soil basis* is active and the mesh set *Culvert* with concrete material is active together with the mesh set *Cover soil*. The BC support set is active.

---

**Analysis browser** → Culvert installation → Geomechanical staged construction → Rise water level → Active model parts  

[Fig. 49]  [Fig. 50]

---

Figure 49: Analysis browser  

Figure 50: Properties stage *Rise water level*
At last the required result items are defined in the output command block. In this analysis we ask for total global displacements, effective Cauchy stresses in global coordinate system, total Cauchy stresses in global coordinate system, the Mohr-Coulomb stress capacity checked at the integration points, the pore-pressure and the Young’s modulus. Then we run the analysis.
3.2 Results

We switch off the deformed shape representation. We check the stiffness and activation of element sets in the different stages. Therefore, we set the result contour plot properties as follows: the color scale limits defined by specified values with a minimum value of $1\times10^{10}$ N/m$^2$ and a maximum value of $3\times10^{10}$ N/m$^2$; number of contour levels equal to 1. We choose grey for the upper bound of the color scale and an amber color for the lower bound of the color scale.

**Main menu**  
Results  
Normalized deformed results  
[Fig. 54]

**Property Panel**  
Result  
Contour plot settings  
[Fig. 55]

---

**Description** | **Value**
---|---
Deformation settings | No deformation
   - Apply deformation in X direction
   - Apply deformation in Y direction
   - Apply deformation in Z direction

Contour plot settings
   - Equidistant levels options
     - Number of contour levels

Color scale limits | Specified values
   - Upper bound color
   - Lower bound color

---

Figure 54: Show normalized deformations

Figure 55: Contour plot properties for Young's modulus
Now we display the Young’s modulus contours at the end of each of the 6 stages.

**Results browser** ➔ Culvert installation ➔ Output ➔ Element results ➔ Elastic Parameters ➔ YOUNG

[Fig. 56] - [Fig. 61]

---

**Figure 56**: Young’s modulus at *Initialization* stage

**Figure 57**: Young’s modulus at *Lower water level* stage

**Figure 58**: Young’s modulus at *Excavate soil* stage

**Figure 59**: Young’s modulus at *Place culvert* stage

**Figure 60**: Young’s modulus at *Cover culvert* stage

**Figure 61**: Young’s modulus at *Rise water level* stage
We check the contour plots of the pore pressures $P_R$ for all stages. Therefore, we set the result contour plot properties as follows: the color scale limits defined by specified values with a minimum value of 0 and a maximum value of $8E+4$ N/m$^2$. Further, we choose a deep blue color for the upper bound of the color scale and a light blue color for the lower bound of the color scale. The number of contour levels is set to 7.

Figure 62: Contour plot properties for pore-pressure results
Now we display the pore pressure contour plots at the end of each of the 6 stages.

**Results browser** → Culvert installation → Output → Element results → Pore Pressure → PR

**Fig. 63** - [Fig. 68]

**Figure 63:** Pore-pressure at **Initialization** stage

**Figure 64:** Pore-pressure at **Lower water level** stage

**Figure 65:** Pore-pressure at **Excavate soil** stage

**Figure 66:** Pore-pressure at **Place culvert** stage

**Figure 67:** Pore-pressure at **Cover culvert** stage

**Figure 68:** Pore-pressure at **Rise water level** stage
We check the contour plots of the vertical effective stresses $SE_{YY}$ for all stages. Therefore, we set the result contour plot properties as follows: the color scale limits defined by specified values with a minimum value of $-1.5E+5$ N/m$^2$ and a maximum value of 0. Further, we choose a light brown color for the upper bound of the color scale and a deep brown color for the lower bound of the color scale.

**Main menu ➔ Results ➔ Normalized deformed results 🥰 [Fig. 69]**

**Property Panel ➔ Result ➔ Contour plot settings ✂️ [Fig. 69]**

![Contour plot settings](https://dianafea.com)

**Figure 69: Contour plot properties for effective vertical stress results**
Now we display the effective vertical stress contours at the end of each of the 6 stages.

Figure 70: Vertical effective stress at **Initialization** stage

Figure 71: Vertical effective stress at **Lower water level** stage

Figure 72: Vertical effective stress at **Excavate soil** stage

Figure 73: Vertical effective stress at **Place culvert** stage

Figure 74: Vertical effective stress at **Cover culvert** stage

Figure 75: Vertical effective stress at **Rise water level** stage
Finally, we make a series of contour plots for the Mohr-Coulomb stress capacity SHRCAP for all stages. Here, DIANA calculates the shear stress capacity against the Mohr-Coulomb failure criterion: SHRCAP > 1 means that the equivalent shear stress is higher than the capacity according to Mohr-Coulomb failure criterion. Therefore, we set the result contour properties as follows: the color scale limits defined by specified values with a minimum value of 0 and a maximum value of 1. Further, we choose light brown for the upper bound of the color scale and deep brown for the lower bound of the color scale.

Figure 76: Contour plot properties for Mohr-Coulomb stress capacity results
Now display the Mohr-Coulomb stress capacity contours at the end of each of the 6 stages.

Results browser ➔ Culvert installation ➔ Output ➔ Element results ➔ Mohr-Coulomb failure criterion ➔ SHRCAP [Fig. 77] - [Fig. 82]
Appendix A  Additional Information

Folder: Tutorials/InstallCulvert

Number of elements ≈ 2190

Keywords:
  ANALYS:  nonlin phase physic stagco.
  CONSTR:  suppor.
  ELEMEN:  cq16e ct12e pstrai.
  LOAD:  buoyan elemen head waterl weight.
  MATERI:  elasti isoto porosi soil.
  OPTION:  adapti direct loadin newton regula size.
  POST:  binary ndiana.
  PRE:  dianai.
  RESULT:  cauchy displa effect mohrco pressu stress total.
Disclaimer: The aim of this technical tutorial is to illustrate various tools, modelling techniques and analysis workflows in DIANA. DIANA FEA BV does not accept any responsibility regarding the presented cases, used parameters, and presented results.